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Chapter 1 | Before We Begin 

You Are Here 

Every campaign that I run is informed by my larger marketing framework ‘The Fan Journey’. This 
system, which is based entirely on the journey someone takes from ‘stranger’ to ‘fan’, ensures 
that every marketing campaign serves a greater purpose.


This strategy,‘Fan Generator’, is my main strategy for achieving the ‘Introduction’ stage of the 
‘Fan Journey’. This first stage is where strangers get their initial exposure to your music and 
brand. And, it's important that this stage be accomplished without compromising the ‘Discovery’ 
based origin story of every fan.


Fans need to feel as if they ‘discovered’ your music, and most music based ads violate this 
sacred principle. That is why the ‘Fan Journey’ was invented; to introduce your music to hundreds 
of thousands of strangers while giving them the impression that they are ‘discovering’ you.


Why It Matters 

Before you learn this all-important campaign methodology, it's important for you to understand 
the "Why" behind it. I make sure to emphasize the "Why" behind every single campaign I run so I 
understand the purpose of each strategy.


The Fan Generator generates top-level awareness and exposure for artists - it replaces traditional 
means of exposure such as Blog and Press PR, supporting act touring, radio/playlist promotion, 
and influencer marketing. But why would we want to replace or supplement those means of 
exposure?


Well, these traditional methods of exposure have many drawbacks to them. They are typically 
expensive, exclusionary, and, most importantly, nearly impossible to track and follow up on. And 
critically, for them to be successful as garnering us fans, they must be contextually relevant to the 
market place; there’s no certainty to this approach.


The Fan Finder Generator is a strategy that anyone with good music can use - regardless of 
genre, age, subject matter, or niche. And, it allows for a "Return Path", or a means of following 
back up with those who are exposed to the music, that other methods of exposure do not.


In Facebook and Instagram Ads, you can follow up with new listeners based on the TYPE of 
interaction they had with the initial exposure. So for instance, you could say different things and 
make different offers to those who watched your entire video than you do with those who only 
watched a smaller percentage. This crucial ability allows you to program the entire journey from 
stranger to fan.
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So What Are All The Steps In The Fan Journey? 

Simply put, these are…


• Introduction - How you introduces yourself to your fans


• Education - How you then go on to educate your fans about you/your music


• Permission - How you ask your fans for permission to keep in regular contact with them via 
email etc


• Nurturing - How you nurture your relationship with your fans via recurring content


• Affirmation - How you lead your fans into a committed buying situation where they support you 
financially


• Ascension - How you then lead your fans into a repeat buying situation so they continue to 
support you financially


• Referral - How you guide your fans into referring you to their peers


• Advocacy - How you guide your fans into championing you and your music while cementing 
your fans’ solidarity toward you and your music. This is the ultimate goal!


As you can see there is a logical and methodical approach to gardening real long-term fans for 
your music career. If you’ve ever released a track online only to find crickets, then the chances are 
that either the music isn’t good enough or there’s no fan journey marketing campaign in place.


This journey is very similar to the way a typical business might lead a customer to purchase their 
product and become a repeat buyer, and online businesses in particular tend to use models that 
are very similar to this, so it makes sense that we music artists would also use a customer journey 
model to create a sustainable online business with our music as the product.


I would like to release further ebooks that go through each of these steps, but for now, it’s all 
about getting those fans in the first place, which you can certainly begin to create a business 
around.
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Chapter 2 | Getting Started 

Understanding The Ad Platform 

In order for you to truly leverage the power of Facebook and Instagram Ads, its important that you 
understand how the Ad Platform works. Here I’m going to explain several fundamental 
mechanisms of the Ad Platform that make it so powerful and exciting to use.


1. Facebook/Instagram Ads Is A Dynamic AUCTION


First, you must understand that Facebook and Instagram Ads are an auction. This auction is 
dynamically operating all the time, selling packets of 1000 "impressions" or single views of an ad. 
The cost you pay for this packet of 1000 impressions is called "CPM" or "Cost per Mille" (mille 
means thousand).

When you set a budget for an Ad Campaign, Facebook will automatically create and adjust your 
"bid" for 1000 impressions served to the audience and in the placements that you set for your 
campaign. So, for instance, if you are targeting Tupac fans in the United States to show your 
music video in their "News Feed" placement, Facebook will consider all the bids placed on those 
fans.

In this example, Facebook will not only consider anyone bidding on Tupac fans specifically, but 
also anyone bidding on the same people for the same placement. So, if you are bidding for 1000 
Tupac fans who also happen to like The Outlawz, anyone bidding on the Outlawz will also be 
competing with you (to one degree or another).

Depending on what budget you set, Facebook will try to generate a bid that will win the 
impressions you want, in the placements you want, for the audience you want. However, those 
with a higher budget will have an automatic "CPM bid" that is, on average, higher than yours. 
And, as a result, they will win more impressions (or more high-quality impressions) than you. 
 
2. Facebook Ad Accounts Are Dynamic Assets (They Learn)


When you run a Facebook or Instagram Ad, you are running it through a property that is unique to 
you called an "Ad Account". Your Ad Account is an incredibly important asset because it is a 
"dynamic" asset - it changes over time depending on how you use it.

This is because Facebook Ad campaigns are constantly learning and optimizing (which we'll talk 
about in a second). And, Ad Campaigns consider many different factors when generating you a 
result - including the history of the Page you are advertising for AND the history of your Ad 
Account.


For example: let's say you and I both have an Ad Account, and we create an Ad Campaign for the 
exact same page (say, my music page) with the exact same settings and start it at the exact same 
time. However, I've been using my Ad Account for a year, and yours is brand new.

In this example, the Campaigns will not generate the exact same result. First, the Auction is 
dynamic, so we will be bidding against each other (to a small degree, not enough to matter). 
Because of this, our bids will be entered at different amounts at different times. And, my 
campaign will consider the history of my Ad Account - including all the data about those I've 
advertised to in the past and what their behavior was. In general, if I've been doing great 
advertising on my account, my campaign should perform better than yours.


It is for this reason that the "Facebook Accelerator" and "Get 10,000 Likes in A Nanosecond" 
courses that are being peddled around the internet are so dangerous: they are training your Ad 
Account and your Page to find the wrong people for the wrong reason. But, even if you've fallen 
victim to one of these scams, you can still turn around your Page data by starting a brand new ad 
account and running smart, well-intentioned campaigns.
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3. Ads Optimize Around Many Different Factors


When you run an Ad Campaign, it will run with the exact settings you gave it. So, it will start off 
with the Audience you designated, the Ads you chose, and the Budget you set. It will run in all the 
Placements you selected (Facebook News Feed, Instagram Feed, Suggested Videos, etc.) without 
any bias. It will spread everything evenly across your exact settings.

However, once your Ad Campaign is able to generate 50 or more of the exact result you chose to 
target (your "Objective"), your Ad Campaign will begin to "optimize", or limit the way your ad runs 
to get you a better result.


For instance, imagine you are running an Ad Campaign with the objective of "Video Views" to 
Tupac fans in the United States. Your ad runs 24/7, and it's set to be placed in the News Feed, 
Instagram Feed, and "Suggested Videos" feed. In your campaign, you have set the ad to optimize 
around "ThruPlays", or when someone watches your video for 15 seconds or more.


Once you get 50 or more "15-second views" or "ThruPlays", your Ad Campaign will begin to 
understand more about the optimal (best) settings for your campaign based on what you want. 
For instance, your campaign may begin to recognize that Males aged 35 and up DO NOT respond 
to your ad at all. They refuse to watch it for the required 15 seconds. Based on this outcome, your 
Ad Campaign will limit the budget that is being spent on impressions for 35+ Males. This will stop 
you from spending money on people who do not perform the action you set as your objective.


Ad Campaigns can optimize around demographic settings like these (age, gender, location), but it 
can also optimize around time of day, placement, and bid. If you have set a budget of $5 per day, 
and your Campaign starts with an automatic bid of $2.50 for 1000 impressions, it may learn over 
time that your ideal viewers are not in the $2.50 bracket. You may have to spend $3 per 1000 
impressions in order to get the "right" type of people. So, Facebook will automatically adjust or 
"optimize" your automatic bid. This all happens behind the scenes, you don't have to do anything. 
This is the power of Facebook and Instagram Ads.


Ad Campaigns can also optimize around time of day (if you get more views at certain times than 
others), placement (if you get more views in Facebook News Feed than Instagram Feed, for 
instance), interest (if you get more views from Tupac fans than Biggie fans), and literally thousands 
of other factors.


4. Every Ad Is A Post, Every Post Has A Unique Post ID And Unique Engagement


For every Ad you create, you are creating a "Post". Just like an Instagram or a Facebook post that 
you publish to your page or profile, this "Ad Post" can be liked, commented on, and shared. But, 
unlike your "Published Posts", an "Ad Post" can only be seen in the Ad Platform by the people 
you are advertising to.


On Facebook, you can publish any Ad Post to your Page as a "Published" post, which will be 
important for later lessons in this training. On Facebook AND Instagram, you can also use ANY 
existing post on your Page or Profile AS an "Ad Post" in an Ad Campaign.


It is important for you to understand, too, that engagement (likes, comments, and shares) is 
UNIQUE to the "Post ID". So, if you create two Ads or two Posts that have the exact same text 
and image/video, they will LOOK the same but have different Post IDs. And, because of this, they 
will have different engagement. If someone likes one Post, that like will not show up on its 
identical twin - engagement is UNIQUE to the Post ID.


I tell you this because it will become important for you to "stack" engagement onto a post - 
meaning you will use a single Post ID to run as the Ad for multiple audiences in multiple 
campaigns. This way, every like, comment, and share will accumulate on that post and it will look 
more impressive over time. As engagement accumulates on the post, it will become easier to 
generate new listeners with it - as it will appear as if the post is well received.
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Creating And Linking Your Accounts 

Here I’m going to go over creating your Business Manager account, Ad Account, and linking your 
Facebook Page, Ad Account, and Business Manager account.


Complete the following steps:


1. Log in to your Facebook Account, then visit business.facebook.com


2. Click "Create Account" in the top right


3. Give your Business Account a name, enter your name and email, then click “Next"


4. Enter in your Business Details, select "Promote its own goods or services", then click “Submit"


5. Log in to the email address you gave in Step 3 and confirm your email address


6. You should now be in the "Business Settings" panel of Business Manager. However, if you are 

not, click the top left menu, hover over "All Tools", then click "Business Settings" on the right 
hand side


7. Select "Ad Accounts" from the left-hand menu, click "Add", then select "Create A New Ad 
Account”


8. Give your Ad Account a name, choose your Time Zone and Currency, then click “Next"


9. Under "This Ad Account will be used for", select "My Business”


10. Select your name, turn on ALL of the Permission sliders, then click “Assign"
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11. Select "Pages" from the left-hand menu, click "Add", then click "Add a Page" if you would like 
the Page to be OWNED by your Business -or- select "Request Access to a Page" if you would like 
to have temporary access to the page but release it to someone else at a later time (for instance, 
if you are running ads for another band or artist)


12. Type in the name or URL of your Facebook Page (your artist or band page) and then click 
"Add Page" 
 
12A. If you receive an error message saying you are not the admin of the page, you must give 
yourself admin access to the page:

• Log in to the Facebook Profile that has admin access to the Page you would like to use

• Navigate to your Facebook Page, click "Settings", then click "Page Roles"

• Under "Assign A New Page Role", enter the email you used for your Business Manager 

account, select "Admin" from the drop-down menu, then click "Add"

• Log in to your email and accept the Page Admin invitation

• Log back in to the profile you signed up for Business Manager with, then navigate 

to business.facebook.com

• Click the top-left menu, hover over "All Tools", then click "Business Settings" in the right-

most column

• Repeat steps 11 and 12


13. Click "People" in the left-hand menu, select your name, then click "Add Assets”


14. Select "Pages", select your Page, then turn on all permissions but do not click Save


15. Select "Ad Accounts", select the Ad Account you created, then turn on all permissions 
and click Save


16. Give yourself a pat on the back. You're capable, self-reliant, and you probably just saved 
yourself a lot of money by doing this all on your own.
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Getting Familiar With Business Manager 

Here I’m going to get you familiar with the technologies you now have at your disposal. Facebook 
Business Manager gives you access to a suite of incredibly powerful marketing and advertising 
tools which will give you a massive leg up when looking to market your music...

The tools covered in this lesson are:


1. Audience Insights 
Audience Insights is a research tool that allows you to dig deep into the trillions of data points that 
Facebook maintains about the Facebook and Instagram user base. Using this research tool, you 
can find insanely detailed information about your target audience and, in particular, people who 
are interested in specific genres of music and artists.


2. Ads Manager 
This is where you can create, manage, and tweak your Facebook and Instagram Ad Campaigns. 
You can also use this dashboard to get detailed reporting about the performance of past and 
ongoing campaigns at all 3 levels of a campaign. Using the "Account Review" tab will allow you to 
review how your entire Ad Account is performing.


3. Creator Studio 
This tool gives you access to a suite of features designed for Content Creators operating on the 
Facebook and Instagram platform. From this dashboard, you can create and manage content-
focused posts (primarily videos), add music to content, manage your copyrights on content, and 
even monetize content for Facebook Ads.


4. Page Posts 
This is where you can manage all of the existing posts associated with your Facebook Page or 
Instagram Profile. This includes both posts that you have published to your page or profile (these 
are your actual Facebook and Instagram "posts") and posts that were created as part of an Ad 
Campaign which are not visible to your Instagram and Facebook followers/likes. You may also 
find the Post ID for any post to be used in an Ad Campaign and publish your Ad Posts to your 
Facebook Page from this panel.


5. Automated Rules 
This panel allows you to access and modify any automated rules you have set for your Ad 
Account and Ad Campaigns. 


6. Ads Reporting 
This tool allows you to run reports for Ad Accounts, Campaigns, and even individual Ads in your 
Ad Account. However, there are not many features in this tool that are not already part of Ads 
Manager, and we typically use Ads Manager to get a look at our Ad Reporting.


7. Test and Learn 
This set of tools allows you to test pre-defined hypotheses using the Ads you currently have 
running in your Ad Account. You can run a test for how your ads are impacting conversions on 
your website, and you can also run several audience surveys to the audience you have reached 
with your ads.


8. Analytics 
This is an extremely powerful tool in Facebook's data suite that allows you to analyze data from 
visitors and users across Facebook, Messenger, Instagram, and your Website (using the 
Facebook Pixel). By pairing all of these properties as one data set, you can see the journey a user 
takes from Facebook and Instagram to Messenger and/or your Website - all in one view. This 
feature of Facebook is only useful for those who have A) installed the Facebook Pixel on their 
website and generated a fair amount of traffic and/or B) generated a large amount of activity on 
their social media properties.
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9. Events Manager (Pixels) 
This panel allows you to create and manage Facebook Pixels, which are snippets of code that can 
be installed in your website. When you install the Facebook pixel, any user that visits your website 
is identified by Facebook as a user of the Facebook or Instagram platform. This matches users on 
your website with users in Facebook's data and tracks their use - attributing their activities back 
to ads in your Ad Account or calls-to-action on your Facebook and Instagram page.


10. Events Manager (Custom Conversions)  
This panel allows you to track important events on your website (such as email signups and 
purchases) without installing Standard Events. Standard Events are additions to the Facebook 
Pixel which tell Facebook that a specific conversion event has occurred (email signup, Add To 
Cart, purchase, etc.). For those trying to track conversions that have not been installed on their 
site as Standard Events, Custom Conversions allows you to define conversion events by the URL 
they occur on (ex: yourwebsite.com/email-signup-thank-you).


11. Audiences 
The Audiences panel is one of the most important panels in Business Manager. Here, you can 
create Saved Audiences based off of Facebook's ad targeting data (demographics, geographics, 
interests, etc.). You can also create Custom Audiences based off of interactions that users have 
had with your page, Messenger, or website. And, most impressively, you can use Custom 
Audiences to create "Lookalike Audiences", which are audiences created by Facebook's machine 
learning and made up entirely of the Facebook users who are most like a defined Custom 
Audience.


12. Catalogs 
This feature of Business Manager allows you to upload data about the Products you offer on your 
website so that your Facebook Pixel can recognize when a user is interacting with a given 
product. You can then use the Product IDs to define when a "ViewContent" Standard Event is 
associated with a given product (allows you to track when a user has viewed the Sales Page for 
that Product). You can also track Add-To-Carts by Product ID (the user has added that product to 
their shopping cart) and Purchases (the user has purchased that product). This also gives you the 
ability to dynamically retarget visitors to your website with ads for the exact products they were 
browsing.


13. Settings 
This tool is essentially the settings for your Ad Account. Here, you can set the payment method 
for your Ad Account, modify which Notifications you'd like to receive (and where), and more.
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Getting Familiar With Ads Manager 

Ads Manager allows you to create Facebook and Instagram Ad Campaigns. Unfortunately it 
comes with hundreds of different settings that can make any person of reasonable intelligence run 
away screaming. To make matters worse, these Ad Campaigns occur at three different levels: 
Campaign, Ad Set, and Ad. And, each level has different settings. I know, it's confusing...

In this lesson, we will get familiar with those settings so that Ads Manager is not intimidating you 
throughout this training. 


The settings that you need to know about are: 

Campaign Settings 

1. Campaign Objective 
This setting allows you to tell Facebook what the goal of your campaign is, which is what 
Facebook will optimize around, getting you more of that target "objective" at the lowest possible 
cost. There are 13 objectives available to choose from, but only so many of them are relevant to 
you. This training will teach you how to wield the "Video Views" objective, telling Facebook to get 
you more Video Views on your Fan Finder Ad at the cheapest possible cost.


2. Buying Type 
This tells Facebook what type of campaign you would like to run; Auction or Reach and 
Frequency. Reach and Frequency campaigns are not useful to independent musicians (especially 
those just starting out with Ads). So, you will want to keep this at Auction for all of your 
campaigns.


3. Split Test (on or off)  
This feature, when switched on, turns your campaign into a "Split Test" campaign. Unlike regular 
campaigns, a Split Test campaign will only run for a pre-set amount of time and, when it is 
finished, will tell you which combination of audience and ad performed best. Split Tests can be 
useful to you and we will explore using them in this training.


4. Campaign Budget Optimization (on or off) 
Up until very recently, Facebook Ad campaigns optimized at the Ad Set level, where the budget of 
your campaign was set. Each Ad Set would contain a different budget, and Facebook would 
automatically adjust the settings of that Ad Set and any Ads in it, picking winning combinations of 
settings. Now, Facebook is switching all ad campaigns to include a budget at the Campaign 
Level, which will allow Facebook to automatically determine which Ad Sets you should spend 
more or less on. While this can be confusing right now, it will become clearer as you continue on. 
And, soon, you will only be able to set a budget at the Campaign Level, and the distinction here 
will not be necessary. For now, you should know that you can choose to optimize at the 
Campaign Level (Facebook controls which Ad Sets and Ads get more budget) or the Ad Set level 
(Facebook controls which ads get more budget).


Ad Set Settings 
Ad Sets are housed within a campaign - each campaign may have 1 or more Ad Sets. An Ad Set 
allows you to choose budget, targeting, and placement for a group of Ads that are housed within 
it. You may create multiple Ad Sets to test different budgets, targeting, and placements against 
each other within a Campaign.
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1. Dynamic Creative (on or off) 
When you create an Ad, you must set your Post Text and Image/Video for that given Ad. If you are 
going to include a button, you must set the Link, the Headline, the Button Text, and the Link 
Description (optional). Before Dynamic Creative, if you wanted to test variations of any of these 
settings (for example, 3 different videos with 2 options for Post Text), you would have had to 
create enough Ads to try every different combination (3 videos times 2 post texts = 6 ads).

With Dynamic Creative, you can enter up to 5 variations for every setting of an Ad and Facebook 
will try every combination, eventually finding a winner and distributing budget only to the best 
performing ad at any given time. This has many advantages for Conversions and Traffic 
campaigns, but also many drawbacks that make it less ideal for Fan Finder campaigns. 
Specifically, you cannot stack social proof/engagement on a Dynamic Creative ad or publish it to 
your Page or Profile. The Fan Finder campaign is heavily contingent on social proof and 
engagement, so it is not useful for these purposes.


2. Budget 
In this section, you can set a Daily or Lifetime Budget for your Ad Set. Soon, the Ad Set Budget 
setting will be removed and replaced with Campaign-level Budget Settings. 


3. Schedule 
This section allows you to choose a Start and End date for your campaign or leave your campaign 
to run without an end date. For a majority of campaigns, we do not choose an end date, as any 
interruption to your campaign can cause your results to change.


4. Audience 
This section allows you to define the Audience targeting for your Ad Set. Any Ads in this Ad Set 
will be delivered to the audience you choose here. You may create an Audience from scratch 
using the settings below, or use a Saved Audience that you previously created in your Audience 
panel.


4a. Custom Audiences 
Custom Audiences are Audiences populated by those who have engaged with your Facebook 
Page, Instagram Profile, website, Messenger, and more. Unlike Saved Audiences, Custom 
Audiences have interacted with you in some way in the past. Using a Custom Audience is referred 
to as "retargeting", since you are reengaging with a user who you have already interacted with. 
 
In this section, you can use predefined Custom Audiences as the target for your Ad Set or create 
new ones. You may also use Lookalike Audiences, which are Audiences made up of users who 
haven't interacted with you but are very similar to a Custom Audience in terms of interests, age 
and gender, location, and more.


4b. Locations, Age, Gender, and Languages  
In this section, you can set the geographic and demographic targeting for your Ad Set. If you are 
using a Custom or Lookalike Audience, entering settings here will limit that audience to just those 
who fit the settings you input. 


4c. Interest Targeting 
In this section, you may select interests (psychographic) targeting for your Ad Set. Interests 
include music and musicians, movies, television, and actors, subjects, topics, groups, 
organizations, cultures, hobbies, behaviors, and more. Interest targeting is based off of data that 
has been observed by Facebook in regards to its users. Please note that interests are not the 
same as Pages - just because I like The Black Keys Facebook Page does not mean that I will 
show up in the interest targeting for The Black Keys, and vice versa.


4d. Connections Targeting 
This section allows you to limit your targeting in relation to your Facebook Page and Facebook 
Events. You may choose to target or exclude those who like your page, have responded to your 
event, or people who are friends with your page likes/event respondents.
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5. Placements 
In this section, you can choose where the Ads in your Ad Set will show up. Placement options 
include Instagram Stories and Feed, Facebook Stories and News Feed, Messenger Inbox, 
Suggested Videos (feed on Facebook), and many more. You may also limit your Ad Set to only 
show to certain devices and operating systems.


6. Optimization & Delivery 
In this section, you can change which parameters your Ad Set will optimize around. Essentially, 
this will determine what Facebook considers "success" for your Ad Set - when using the Video 
Views objective, "success" can be a 2-second view, a 10-second view, or a 15+ second view. 
Facebook will use data about these "successful" actions to determine how to change or 
"optimize" your campaign to get you a better result at a lower cost.

You may also set a "Bid Strategy", which will tell Facebook to optimize for a different bid amount 
depending on what you choose. This is an advanced function of Facebook Ads that should only 
be used by experienced media buyers.


Lastly, you may set "Standard" or "Accelerated" delivery. Standard Delivery will distribute your 
Daily or Lifetime budget equally across hours and days. Accelerated Delivery will spend more of 
your budget as soon as your campaign starts running.
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Ad Settings 
Ads are housed within Ad Sets. Each Ad Set determines how, to whom, and where the Ad will run. 
Whether you are using an Ad Set budget or a Campaign-level Budget, if you have multiple ads in 
a given Ad Set, Facebook will use more budget on the one that performs best. This allows you to 
test Ads against each other within Ad Sets. 


1. Identity 
In this section, you can select which Facebook Page and Instagram Profile you would like your Ad 
Posts to be housed under. Your profile/page information will be displayed in your ad (profile 
picture and page name/link) and all the data from your Ad Campaign will be attributed to the Page 
and Profile you have selected.


2. Ad Creation Window 
In this section, you can use various parameters (such as video/image, post text, etc.) to create 
your Ad Post. Each "Ad" corresponds to a specific Post in Facebook. You may also choose to use 
an existing post instead of creating a new one, including a post that is published to your 
Facebook Page or Instagram Profile.


2a. Creative 
In this section, you can choose to use a Video or Image in your Ad. You may also choose to show 
an "Instant Experience" or "Carousel" ad, which are more complicated versions of an Ad Post. For 
this strategy, you will be using a single Video in your ad.


2b. Post Text 
This is the text of your Ad Post - generally, when creating a Post on your Page or Instagram 
Profile, this is what you type in. We typically use this space for an attention-grabbing or curiosity-
driving headline.


2c. Website URL 
For any Post being used as an Ad, you may choose to add a Website URL and corresponding 
Button. When you do use this feature to publish a Post, however, that Post will permanently show 
a Call-To-Action Button on it. You cannot change this once it is done.


2d. Button Text 
When you add a Website URL Button to a Post, you can choose from 12 different Calls-To-Action 
(depending on what kind of campaign you are running) to serve as the Text on the Button.


2e. Headline 
When you add a Website URL Button to a Post, you may include a Headline which will appear in 
bold next to the Button under the Post Creative.


2f. Link Description 
When you add a Website URL Button to a Post, you may include a paragraph of text which will 
appear underneath the Headline on the Post.


2g. Multiple Languages 
This setting allows you to add translations of all other text in your Post for users who speak a 
different language.
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DISCLAIMER: Important Changes 
 
1. In 2019, Facebook announced that they would be removing the ability to set budgets at the Ad 
Set level of a Facebook Ad Campaign. Instead, the budget would be set at the Campaign level. 
Since this announcement, Facebook has changed their position and will not be removing Ad Set 
budgeting. Please be advised that this change does not affect the strategy of any Indepreneur 
training or campaign. However, some lessons may mention an upcoming change to mandatory 
Campaign level budgeting (which is no longer happening). 


2. The user interface of Facebook Business Manager changes very frequently. Features and 
screens displayed in these lessons may not match what you see when you use Facebook Ads or 
other Business Manager tools. Though we cannot update these lessons as quickly as Business 
Manager changes, we will update any time a feature is removed from Business Manager or is 
otherwise no longer available.  
 
If a tool or feature mentioned in a training is moved but not removed, you can find it by searching 
for it. Facebook Business Manager displays a search function that will allow you to search for a 
feature (or a help document about that feature) if you can’t find it. 
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Chapter 3 | Preparing Your Audience 

Understand Audience Targeting 

PLEASE NOTE: The recommended location targeting for most Facebook Ad campaign strategies 
has been changed to account for a massive influx of suspected bot traffic in many European 
countries. Until this issue can be understood, it is recommended that you only target 
audiences in the United States, Canada, Australia, New Zealand, and United Kingdom. We 
will post any updates to this issue as it evolves!


Before we begin building your Target Audiences for your initial advertising campaigns, it's 
important to understand how Audience Targeting works in the Facebook and Instagram Ad 
platform.

Because of modern social advertising platforms like Facebook, we can now, for the first time in 
history, target audiences based on their psychographic interests. Whereas, before, we had to use 
the placement of the ad as the only way to target (i.e. what magazine you advertise in, what TV 
show you advertise on, etc).


In Facebook, you can use interest targeting to reach audiences that have never interacted with 
your brand before. Facebook uses millions of data points to determine what your interests are, 
and advertisers can run ads against those interests. 


Facebook can't give you access to all the data it has on a given user or group of users - it would 
violate data privacy laws. However, Facebook can apply machine learning to match your 
advertising objectives to target audiences. You can unlock this power by using Lookalike 
Audiences, which are automatically generated audiences based on a "seed audience".

Using "interest" based targeting, you can build up your "Custom" audiences, which are audiences 
that have interacted with you in the past. You may run a music video of yours to an audience of 
people that are interested in a similar artist, generating thousands of 25%, 50%, and 75% video 
views from that audience.


Then, you can create a Custom Audience of those who watched a certain percentage of your 
video, and give it to Facebook as the "scent" or "seed audience". Facebook will find 
you x percentage of y countries that look most like that seed audience. These "Lookalike" 
audiences typically perform far better than audiences based off of interest targeting.

Because of these functions, it is important to get your ad account started with the best possible 
interest-based targeting so that you are feeding the correct data BACK to Facebook. This will 
allow you to consistently lower your ad costs while increasing performance in your ads.
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Building Our Targeting List 

How you target your audience on Facebook can have a dramatic impact on the effectiveness of 
your ad campaigns. In this lesson, our goal is to create isolated groups of "interests" that we can 
target which do not have much "overlap", meaning they represent distinct differences in the type 
of person you're targeting and the types of music they listen to. 
 
Follow these steps to complete your targeting worksheet: 
 
1. Use the Worksheet template 

2. Navigate to page 4 of the Worksheet

3. In the left-hand column, list 7 artists or bands whose music you believe sounds closest to your 
music

4. Show your music to several people who have not heard it before or don't know it well and ask 
them who it sounds most like

5. In the right-hand column, list 7 artists or bands whose music they believe sounds closest to 
your music

6. Navigate to business.facebook.com and, in the top left menu, hover over "All Tools" and then 
click "Audience Insights" (if you do not see Audience Insights, first visit "Creative Hub")

7. Select "Everyone on Facebook"

8. In the Location targeting, enter in the following countries:

• United States

• United Kingdom

• Canada

• Australia

• New Zealand


9. Select the "Page Likes" tab at the top of the Audience Insights panel

9. Navigate to page 11 of the worksheet

10. Enter the "Seed Artist" listed on this page of your Targeting Worksheet into the "Interests" 
targeting of the Audience Insights panel

11. Scroll down to "Page Likes" and find the 7 artists who have the highest "Affinity Score" to 
your "Seed Artist"

12. Turn to the next page of your Targeting Worksheet and repeat steps 9-12 until all Seed Artists 
have been researched

If you encounter any trouble in creating your Targeting Groups, please watch the video lesson for 
troubleshooting help.
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Creating Our ‘Saved Audience’ 

In this lesson, we are going to build the Saved Audiences which will get your Ad Account off on 
the exact right foot and generate a massive listener base for you. They will also help you populate 
your Custom Audiences so that you can begin "retargeting" listeners into deeper stages of the 
relationship.

It is advised that you closely watch this lesson before attempting to complete this process. 
However, for a text-based representation of the process, you may follow these steps:

1. Navigate to the final pages of your Worksheet, which should contain all of your interest 
targeting in groups

2. Navigate to business.facebook.com and, in the top-left menu, hover over "All Tools" and select 
"Audiences"

3. Click "Create Audience", then select "Saved Audience"

4. Name your Saved Audience after the first Seed Artist in your audience targeting groups, which 
is displayed with a larger font than other artists

5. Under "Locations", click "Browse", then click "Saved Locations" and select the "Green Light 
Countries" list we created in the last module - if you have not created this Saved Location list, 
follow these steps:

• Under "Locations", click "Browse" then click "Saved Locations" and select "Create List"

• Under "Location type", select "Countries"

• Enter the following countries: United States, United Kingdom, Canada, Australia, New 

Zealand, Ireland, Norway, Sweden, Switzerland, Austria, Germany, Japan, France, 
Netherlands, Belgium


• Click "Match Locations"

• Select "Save this list to use it again" in the bottom right, then click the blue "Add Locations" 

button

• Under "List Name", enter "Green Light Countries", then click "Save List"


6. Under "Detailed Targeting", enter the artists and bands (including the Seed Artist) in your 
Audience Group - if a majority of your artists/bands are not targetable, please reference the video 
lesson

7. When you are finished, click "Create Audience"

8. Repeat steps 3-8 until all of your researched Audience Groups have been created as Saved 
Audiences

If you have any trouble during this process, please reference the video lesson for help with 
troubleshooting.
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Chapter 4 | Preparing Your Video Ad 

Recommended Video Length 

Of the things most artists get wrong when they first start running ads, a big one is the type of 
video they choose to run as an ad and what they write in the post text of that video ad. If these 
things aren’t completed properly, they can ruin an otherwise decent ad campaign. I often see 
completely the wrong type of video ad coming out from artists trying to promote their music 
online, in fact what we want to be doing is typically the exact opposite of what we see major label 
artists doing.


Here I’m going to go through best practices, so your video ad will perform extremely well on the 
platform it is optimised for, and most importantly so that you get people to listen to your music for 
a long period of time. You must be getting people to listen to 75% plus of your video otherwise 
you won’t be generating true listening fans for your career.


Which Video Works Best? 

Since the dawn of MTV, music videos have been prepared to be viewed on home televisions. It's 
not our fault - it's just sort of how things ended up. We never anticipated that, one day, the world 
would be viewing videos on screens the size of your palm in a globally connected network of 
socially shared information. 
 
In this lesson, we break down why traditional music videos may not perform as well on social 
media. We also go over the different types of atypical music and performance videos that have 
performed the best over a year and a half of rigorous testing and tens of thousands of dollars in 
ad spend.


Rules To Follow When Creating Videos:


1. The first 5-10 seconds of a video must capture the viewer's attention

2. The viewer should believe they are part of a real experience (suspension of disbelief)

3. The video should appear to be shared by a person, not a company (don't look like an ad)
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Videos That Work Very Well 
 
The following types of videos have been used by multiple Indies with great success, and you can 
choose a format (or mix of formats) from these examples to create a great Fan Finder video.


1. Public Performance Videos 
 
Example: "Lady of the Night" by DUX  
Viral videos featuring music typically are shot on a cell phone in a public place - the person 
recording the video stumbled upon a talented musician in their normal daily routine. These videos 
work very well because they do not invite disbelief and allow the viewer to feel as if they are part 
of an exciting, talented community.

To make one of these videos, you simply need to select a well populated public setting as your 
location for the video. Then, do your best to add elements of heightened emotion to the video, 
such as introducing an element of risk or public interaction (for example).


2. Single Shot Performance Videos  
Example: "What To Do" by The 502s  
One of the main issues with most music videos is that they introduce disbelief and disconnection 
by cutting around scenes. Unless I am already engaged with the brand, artist, or song, it is 
unlikely that heavy cinematography and multiple locations is going to invite a viewer into the 
experience. It will more likely deter them; making them feel as if they've stumbled upon something 
they are not involved in. Instead, this video relies on smooth single camera motion with no cuts.


3. "Talented Friend" Videos 
Example: "Everybody Wants To Rule The World" by Ted Yoder 
These are the types of videos that most often go viral - cell phone recordings of someone 
displaying their talent in a common setting. The internet is in no shortage of amazing cinematic 
music videos with incredibly high production value; still, for some reason, shaky cell phone 
footage of talented singers/instrumentalists/producers go viral far more often than the more slick 
and polished clips.

To create a video like this, all you need is a talent that lends itself more to soloing - a visceral 
talent that is obvious upon first glance. If your talent is songwriting, there's nothing wrong with 
that - but it's not something that can be appreciated in a quick 10 seconds. It takes more 
investigation and understanding.


4. "Cover Spin" Videos 
Example: "You're A Mean One Mr. Grinch" by Small Town Titans  
YouTube is not hurting for cover videos - every musician's first idea when trying to promote their 
music on that platform is to cover popular songs. However, those covers typically do very poorly 
when compared to the "Cover Spin" type of video...

To create a Cover Spin, you want to identify what musical genres are most opposite your genre. 
For example, synth-pop is vastly different from hardcore music. If a synth-pop artist covered a 
hardcore song, or vice versa, that would be a "Cover Spin". These videos typically do very well - 
in fact, the very best performing Fan Finder we've seen is the example above. While covers aren't 
the best way to introduce listeners to your original music, they can generate a large amount of 
exposure (and revenue) if successful enough.

Unlike the other video types in this list, a Cover Spin video can include multiple camera angles, 
shots, settings, and higher production value.
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Videos That Don't Perform 
 
The following types of videos have historically underperformed for Indies in our community. You 
should avoid using videos that fall under these categories.


1. Epic Videos 
To put it simply: the average viewer's life is not filled with beautiful mountain ranges and massive 
ocean waves. By introducing epic settings and cinematography into your video, you are often 
times removing the viewer from the video. You are creating separation between the content and 
the person watching that content. While this works great for travel vlogs, it typically flops when 
used to promote a song.


2. Story Driven Videos 
Music videos that include a story are already pretty difficult to follow. Stories are usually driven by 
exposition - meaning, characters typically have to speak in order to push a story along. Since 
there is no dialogue in a music video, it's very difficult to understand what the story is.

Add to that the fact that your average viewer is scrolling their social media feed and not paying 
attention, and you've got a recipe for disaster. So, even though story-driven videos can be very 
beautiful and engaging for existing fans, you should not use them to create new fans unless you 
already have a large, built-in audience.


3. Multi-Shot Performance Videos 
Aside from not being very immersive due to multiple sets and camera angles, there's no great 
psychological reasons why these videos shouldn't perform well. They all seem to lack an "it" 
factor. But, if you're looking for a smoking gun that proves why these videos fail so often, you 
won't find one. They just don't typically work very well.


�22



Creating Your Video 

It is more often the case that successful Fan Finder videos are "created" rather than "selected". 
Meaning, it is in your best interest to create a new video for the purpose of this video campaign. 
And, in this lesson, we're going to ensure that, regardless of how you want to go about it or what 
budget you have, you can create something that works really well for this method.

Below, we have listed three different options for getting your Fan Finder video produced. We have 
also listed all the information you need to know in order to successfully achieve each option:


1. Buy A Camera, Shoot It Yourself 
 
Last year, we ventured into the world of videography by purchasing a camera system for the 
company and learning as much as we could about the craft. And, it didn't take long for us to learn 
how to achieve great-looking shots with a minimalistic setup.

While we know that most Indies will not want to tack on a whole separate (and, often, expensive) 
craft to their already laborious musicianship, we would feel as if we were cheating you if we didn't 
recommend it. There is no skill you could learn as quickly as videography that would save you 
more money or generate you more results in the long run.

If you would like to learn how to use cameras and create your own videos, the following setups 
can get you started…


Low Budget Cameras ($500-$1000)  
 
Cameras 
- Sony A6300 ($850) 
- Sony A6400 ($1000) 
- Sony A7 ($1000) 
- Canon M50 ($600) 
- Canon EOS T7i ($740) 
- Fujifilm X-T20 ($1000) 
- Panasonic Lumix G7 ($500) 
- Panasonic Lumix G85 ($700) 
- Black Magic Pocket Cinema Camera ($1000) 
 
Medium Budget Cameras ($1000-$2000) 
- Sony A7II ($1100) 
- Sony A7III ($2000) 
- Canon EOS 6D Mark II ($1650) 
- Panasonic Lumix GH5 ($1700) 
- Fujifilm X-T3 ($1780)

Big Budget Cameras ($2000+)  
- Sony A7SII ($2900) 
- Canon EOS-R ($3000) 
- Canon EOS 5D Mark III ($3020) 
- Nikon Z6 ($2100) 
- Panasonic Lumix GH5 [BUNDLE] ($2300) 
- Panasonic Lumix GH5S ($2840) 
 
Gimbals (stabilizer) 
- Zhiyun Crane v2 ($300) 
- Zhiyun Crane Plus ($370) 
- Zhiyun Crane 2 ($550) 
- DJI Ronin-S ($560) 
- MOZA AirCross ($300) 
- MOZA Air ($400)
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2. Hire A Videographer ($100-$1000) 
 
This option is the most budget-friendly while still maintaining a high image quality. There are many 
job boards (including Craigslist) where videographers post their services. However, the types of 
equipment your videographer has can represent a higher or lower price for their services.

We advise that you watch the video lesson to get a full understanding of budget ranges and 
necessary equipment. However, we advise that you hire a videographer who has a mirrorless 
camera capable of shooting 4k video at high bit-rates and in a flat color profile (like Canon C-Log, 
Panasonic V-Log, or Sony S-Log). For certain video types, it will help if your videographer also 
has a gimbal or some other way to stabilize their shots.

When you have found the right videographer, it will be most budget-friendly for you to hire them at 
an hourly rate. Since most Fan Finder video types do not require much setup, lighting, time, or 
travel, you should be able to contract a videographer for just one or two hours and get everything 
you need. You may also want to retain them to edit your video.


3. Shoot It With Your Smartphone 
 
If your phone was released within the last 2-3 years, chances are you have a fairly powerful 
camera already at your disposal. However, it's not so easy to make a smartphone video look like it 
wasn't shot on a smartphone.

In order to achieve this look, we recommend that you consider investing in the following tools:


1. Filmic Pro  
This iOS/Android app will unlock the true power of your phone's camera, affording you all of the 
advanced camera settings that make DSLR/Mirrorless cameras so capable. With this app, you 
can dial in your exposure settings and shoot in a flat (LOG) profile using your smartphone.


2. Moment Lens 
Moment makes lenses for smartphones - and they will undoubtedly improve your image quality 
and give you more flexibility in the look you want to achieve. However, they aren't need-to-haves 
for making great smartphone videos.


3. DJI Osmo Mobile 2 
This gimbal provides much-needed stability to your smartphone videos - it will look like the 
camera is floating on a cloud. And, at $140, you will find no better smartphone gimbal for the 
price than DJI's Osmo Mobile 2.


Earning Attention 

• Stop! Most musicians ruin their chances of success by making this one simple mistake! In this 
section I’m going to tell you exactly what that is and how you can avoid it! That was a ‘pattern 
interrupt’.


• Use something like this to stop people scrolling past your video at first glance. They need a 
‘pattern interrupt’ to stop them and make them want to see what your video is about. 


• Often people ‘bury the lead’ by not communicating why the their viewer should watch, right at 
the start of the video. It’s similar to how Friday Night guest shows tell us who is on the show 
that night and why they need to watch it. There might be funny moments that they’ll show 
glimpses of that will keep the viewer feeling good and excited about watching the whole way 
through because there’s this treat that they know is coming.


• On this note, don’t take 20 seconds before singing or running some long intro

• Don’t post the director’s name or the artists name at the front, no one cares!

• The first 5-10 seconds are sacred and you must show exactly what and why the viewer should 

watch in these seconds.

• Basically put the very best part of the video at the front first. You can still run the video after 

this.

• Cheaper ways to ‘pattern interrupt’ might be to use lots of motion, to tell someone to stop, 

bright colours, a fire, backflip, ‘fist fight’, something ‘high energy’ like that will often make 
people stop.
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Writing Headlines 

In marketing, the written word is king. "Copywriting", or writing for a desired result, represents a 
solid chunk of all the marketing knowledge ever published. And, for good reason! The difference 
between a well performing video campaign and a campaign that completely flops can often be 
the sentence (or full-length novel) you put above your video.

It can be easy to make mistakes in writing copy for the Introduction stage campaign in your 
Buddy System. In this mini-lecture, we'll unpack the different headline writing practices and 
strategies that have yielded massive results for us in the past. 


Headlines That Work Well: 

1. Audacious Claim 
 
Example: "The craziest rap verse ever?"  
This headline type relies on stark braggadocio - making a bold statement or claim that the video 
should provide evidence for. This headline type should only be used when the video includes a 
visceral talent (see video for details).


2. Pattern Interrupt 
 
Example: "look, we know how this works. this is an ad..." 
This headline type works by standing out in stark contrast to the types of posts a viewer is seeing 
in their social media feed. A great ‘pattern Interrupt’ headline gets a viewer to stop by leading with 
a sentiment or sentence that is not typically found on social media posts or ads. The "anti-ad" 
format works very well in this context - instead of trying to circumvent the fact that you are 
advertising, you could attack it head on and actually talk about it. That's a very welcome break 
from the norm. However, this is not the only way to break the pattern - you should find your own 
creative way to stand out in your News Feed.


3. Tease 

Example: "This looks like so much fun..." 
This headline type is a light touch that can work very well. By keeping your headline short and 
sweet and using ellipses to carry viewers into the next step, you can generate curiosity and earn 
attention. While this isn't a surefire way to write a headline, sometimes it can be your best option 
(depending on the type of video and genre). Tease headlines lack story elements (premise, 
conflict, resolution), instead relying on emotions or imagery to drive curiosity.


4. Narrative Loop 
 
Example: "FIND OUT how this rapper just ruined EVERY major endorsement deal..." 
Anyone who writes content is familiar with the concept of "open loops". By failing to resolve key 
points in your story, you can often guarantee that will interact with you again. And, by failing to 
resolve a story that your headline begins, you can ensure that more viewers will end up watching 
your video.


Put simply, a loop is an unresolved narrative. If you can deliver the premise for an interesting story 
and leave out the conclusion (or vice versa), you can naturally and silently encourage your viewer 
to watch your content. 


5. Question 
 
Example: "Why don't rappers go this hard anymore?"  
Questions are natural unresolved narratives. They are, by design, open loops that beg for an 
answer (or a "resolution"). The reason that many social media copywriters rely on questions is 
because they work very well - they engage your audience by requiring their feedback but also 
ensure consumption of content. Your viewer is forced to watch the content in order to understand 

�25



the question and give their answer. And, once a question has been asked of you, it is very difficult 
to just walk away (or keep scrolling).
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Chapter 5 | Setting Up Your Campaign 

Monitoring Tools 

Once you add your Facebook Page to Business Manager, you will lose the ability to monitor your 
page activity from the regular Facebook app on your mobile device. Don't worry! There is a much 
more powerful tool that will help you separate your personal Facebook activities from your music 
page maintenance.


‘Pages Manager’ is a powerful mobile app that will allow you to manage multiple pages at once 
with many of the same options and functions as your Business Manager account.


In your first year of running ads, you may constantly want to check your ad’s performance - 
maybe even obsessively. To get a quick glance at your ad campaigns on the go, you can use 
'Facebook Ads for Mobile'. This app, while not as robust as is claimed in this video, will help you 
get a view of some important metrics on your campaigns when you can't get to a computer.


Testing Headlines 

Depending on how strongly you feel about your headline ideas, you may want to test multiple 
headlines to see which one works best. By following the steps in this lesson, you can split-test 
your headline ideas against each other and let the data tell you which one is the most optimal for 
finding new fans.


For this test, we advise that you narrow your headline options down to 5 or less. However, if you 
simply MUST test more than 5 headlines, you can scroll down and follow the instructions for that 
process.


For testing 5 headlines or less:


1. Log in to business.facebook.com

2. In the top-left menu, select "Audiences"

3. Click "Create New Audience" > "Saved Audience"

4. Name the new audience "All Interests (Testing)"

5. In the "Location" targeting, enter in all Green Light Countries

6. In the "Detailed Targeting" section, enter in ALL of the interests from your Targeting 

Worksheet

7. Click "Save Audience"

8. In the top-left menu, select "Ads Manager"

9. Click the green "Create" button in the middle of Ads Manager on the left-hand side (NOTE: If 

you are viewing "Guided Creation", click "Switch to Quick Creation")

10.Title your campaign "VV - [INSERT SONG NAME] - Headline Test"

11.Set the bid type to "Auction" and the objective to "Video Views"

12.Name your Ad Set and Ad "Headline 1" 

13.Click "Save To Draft"

14.Check off the "Headline 1" Ad Set and then click "Edit"

15.Change the budget to $5.00 per day

16.Select "Manual Placements", then deselect all but "Facebook News Feed" and "Facebook 

Video Feeds" (NOTE: If you would like to include an Instagram version of your Fan Finder, 
select Instagram Feeds and Instagram Explore)


17.Check off the "Headline 1" Ad and then click "Edit"

18.Set the correct Facebook Page and Instagram Profile

19.Click "Select Video", then upload your Fan Finder video and click "Continue"

20.Under "Text", type in your first headline

21.Click "Select a placement to customize", then click "Instagram Feed"

22.Click "Edit", then click "Change Video" and upload a 120-second (or less) version of your 

Fan Finder video

23.If you would like, modify the Text, Thumbnail, and Crop of the Instagram version of your Fan 

Finder ad
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24.Check off the "Headline 1" Ad Set and click "Duplicate"

25.Create as many duplicates as needed to test all remaining headlines

26.In the Edit Panel, change the name of each Ad Set to reflect the different headline variants 

("Headline 2", "Headline 3", etc.)

27.Select each Ad and change the Ad Name and Primary Text until all headline variants have 

been entered

28.Return to the main Ads Manager window by clicking "Collapse Side Pane"

29.Click "Review and Publish", then click "Publish"

30.After $5-$10 has been spent on each Ad Set, turn off the Campaign and move on to the next 

lesson


Analysing Test Results 

Analysing test results is a highly variable process. The metrics you examine and use to determine 
your best option will depend entirely on what goals you want to prioritize; do you care more about 
engagement, view count, view length, page likes, post comments, etc.?


Here I’m going to explain how to use Facebook Ads Manager to learn a large volume of 
information about your Ads and Campaigns using Performance Analysis.


By this point you should have run your ad for 24 to 48 hours and have results back for this.


So, looking at the ad level of our results, there should be ‘quality’ and ‘engagement rate’ ranking. 
These are predictors of future performance, so if either of these rankings is above average, this 
means your costs are expected to go down over time. If they’re below average, then its expected 
that the cost will go up over time.


It’s nice to use these rankings when you want to decide between two or more ads that might be 
performing well, say for a 75% cost per view. In which case you can choose the ad with the best 
quality and engagement ranking.


Sometimes Facebook can take some time to generate the quality and engagement rankings, so if 
you don’t have this data from your results yet, it’s recommended that you spend $5 to $10 on 
each headline. $5 will get you enough data to decide on a winning ad, but $10 will certainly give 
you more data and thus a more confident decision.


Continuing on… Looking at our headline test data, head over to the ‘columns’ drop-down and 
select ‘customise column’. Here you can select any of the various performance metrics that you’d 
like to see in your dashboard as you review your data. I recommend deleting all the options and 
then turning on ‘reach’, ‘amount spent’, ‘click all’, ‘cost per click all’, and ‘click through rate all’. 
Then also ‘quality’, ‘engagement rate ranking’, ‘CPM’ (cost per thousand impressions), ‘page 
likes’, ‘post comments’, ‘post reactions’, ‘post saves’, ‘post shares’, ‘cost per page like’, and 
‘cost per post engagement’. Also if you’d like to know how your ad led people to message your 
page or profile, you can turn on ‘new messaging connections’ and ‘messaging conversations 
started’, as well as the ‘cost per’ for each of these two metrics.


Next we get to the video specific metrics. Let’s turn on ‘3 second video plays’, ‘video plays 
at’ (25%, 50%, 75%, 95%). Also turn on ‘video average play time’ and ‘cost per 3 second video 
play’.


Simply press ‘apply’ to make these metrics show up on your dashboard. You can also save this 
dashboard configuration by selecting the columns drop-down and pressing ‘save’.


It’s important to always view your data with a ‘cost per click’ perspective. Facebook sometimes 
shows this metric for you, but not always, so do bear this in mind. You may need to do a little 
manual calculating for this, for instance simply take the ‘amount spent’ and divide it by the 
number of clicks; this will give you the cost per click.
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Again, your campaign goal will dictate which metric you're looking to optimise for. Typically ‘cost 
per click’, ‘click though rate’, ‘clicks’, ‘shares’, or ‘video views’, but play around with the data, 
looking at it from as many perspectives as you wish.


I like to look at the ’75% views’ making sure I calculate the cost per 75% view, because these are 
the people who we want to focus on; they’re the people who actually watched the video to 75% 
or more. Engagement is also one of my favourite metrics to optimise for because this type of 
video will typically continue to bring in new fans over time and not fatigue so easily due to its high 
engagement quality. You’ll likely want to study these metrics for a while and figure out which 
video/headline is best for you and what you’re trying to accomplish. Remember, it doesn’t 
necessarily have to be one metic that you decide to pursue; it may be that you find a balance of 
say ’75% views’ and ‘engagement’ that you’ve optimised for with your selection.


Some further thoughts… Are you going to optimise for the largest warm audience you can get, 
because you have something for them afterward? Are you looking for a high volume of one-to-one 
interactions, perhaps optimising for engagement? Or do you want to optimise several metrics and 
therefore keep several of the ads running. Figure this out so you get the most out of your test data 
going forward.


OK, so in most cases you’re going to want to go with just one of the ads. So once you’ve 
decided, simply …


• Select that ad (tick the lil box) and click ‘edit’ so that the editor window slides across the 
screen.


• On the right hand side of the screen by the ad preview, select the drop-down icon at the top 
right of that ad preview, and then select ‘Facebook post to comments’. This will take you to the 
actual Facebook post of the ad itself.


• Below the username (next to the profile image) of the post, you’ll see a tiny time stamp. Click 
on that. This will take you to a dedicated page for that post.


• In this new post window, select and copy the long string of numbers at the end of the URL and 
head back to the Ads Manager.


• Now back in the Ads Manager window, select the ‘Ad Setup’ drop-down and select ‘Use 
existing post’.


• Below this you’ll see ‘enter post ID’. Select and paste in the long string number you copied 
from your ad URL, then press ‘submit’.


Now you’ll find that your chosen post is setup as your ad. Be sure to make a note of that long 
string number for future reference, you’re going to need it!


Also, shut off your campaign for now; we’ll be creating a full fan generator campaign with it turned 
on next!


Creating Your Video Views Campaign 

At long last, the moment has finally arrived... 

Now that you have the right headline, video, and extensive knowledge of Facebook Ads all ready 
to go, it is time to finally create your Fan Generator campaign! Follow the steps in this lesson to 
create your campaign and begin running it for the initial 24-hour testing phase.


Before you get started, you want to choose whether you will be using Campaign Budget 
Optimization or Ad Set Budgeting.


When you use Campaign Budget Optimization (CBO), Facebook will ask you to set a Daily 
Budget or Lifetime Budget at the Campaign Level. When your Campaign begins running, 
Facebook will first distribute your budget evenly to all of the Ad Sets and Ads in your Campaign. 
After your Campaign begins generating results, the Campaign will use data to adjust the amount 
of budget being distributed to each Ad Set and Ad. Ad Sets and Ads which achieve greater 
results at lower costs will receive a larger portion of the budget than other Ad Sets.
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In a typical Fan Generator Campaign, the only difference between Ad Sets is the Audience being 
targeted. When you use Ad Set Budgeting, you will set a budget for each Ad Set. This allows you 
to run your Campaign for 24 hours and then manually optimize based on the results achieved 
during that period.  


To do this, you will turn off underperforming Ad Sets and only leave on the Ad Sets which are 
achieving the greatest performance.


Campaign Budget Optimization uses Artifical Intelligence to optimize around the Campaign 
Objective. In a Fan Generator Campaign, a primary goal is to generate "deep views", or to get 
users to watch a majority of the video. The Video Views Campaign Objective optimizes for 15-
second views. As a result, when using CBO, Facebook may choose to spend a majority of the 
budget on Ad Sets which are generating cheap 15-second views at the lowest cost, but not 50% 
or 75% views. When using Ad Set Budgeting, you can choose to only run Ad Sets which are 
generating 50% or 75% views at the lowest cost.


This doesn't mean that CBO is not a great option under certain conditions. CBO campaigns allow 
for much greater scale and flexibility. Because Facebook considers every audience member when 
optimizing through artificial intelligence, CBO campaigns can adjust over time. So, even if certain 
Audiences eventually grow stale, fatigued, or become more hotly contested in the Ad Auction, a 
CBO campaign can adjust to always ensure the lowest cost views.


If you prefer a set-it-and-forget-it approach and want to leave your campaign running without 
much maintenance, you should use CBO. If you prefer to have full control and make manual 
adjustments over time to ensure the best possible performance, use Ad Set Budgeting.


Follow the steps in this lesson to create your campaign and begin running it for the initial 24-hour 
testing phase.


To create your Fan Generator campaign on Facebook:


1. Log in to business.facebook.com

2. In the top-left menu, select "Ads Manager"

3. Click the green "Create" button in the middle of Ads Manager on the left-hand side (NOTE: If 

you are viewing "Guided Creation", click "Switch to Quick Creation")

4. Title your campaign "VV - [INSERT SONG NAME] - FB"

5. Set the bid type to "Auction", the objective to "Video Views", and turn on "Campaign Budget 

Optimization"

6. Set your Campaign's Daily Budget anywhere from $10 to $50+

7. Name your Ad Set "[INSERT NAME OF SAVED AUDIENCE] - FB" (i.e. if your first audience is 

"Led Zeppelin", name the Ad Set "Led Zeppelin - FB"

8. Name your Ad after the song in your Fan Finder

9. Click "Save To Draft"

10.Click the "Ad Sets" tab, then check off your first Ad Set and click "Edit"

11.Click "Use A Saved Audience" and then select the corresponding Saved Audience from the 

drop-down menu

12.Click "Edit Placements" and ONLY select "Facebook News Feed" and "Suggest Videos"

13.Click on the first Ad in the left-hand side of the Edit pane

14.Set the correct Facebook Page and Instagram Profile

15.Click "Select Video", then upload your Fan Finder video and click "Continue"

16.Under "Text", type in your headline

17.Return to the main Ads Manager window by clicking "Collapse Side Pane"

18.Turn off your Ad using the blue switch (grey means "off", blue means "on")

19.Click "Review and Publish", then click "Publish"

20.In the top-left menu, hover over "All Tools" then select "Page Posts"

21.In "Ads Posts", find your newly created Ad and highlight the Post ID (long string of numbers) 

to copy it to your clipboard

22.Return to "Ads Manager" and click the "Ad Sets" tab
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23.Check off your first Ad Set, then click "Duplicate", creating as many duplicates as you have 
Saved Audiences left


24.One by one, change the name and Saved Audience of each Ad Set until all of your Saved 
Audiences have a corresponding Ad Set


25.Navigate to the Ads Tab, select all the Ads in your Campaign, then click "Edit"

26.Under "Creative", choose "Use Existing Post", then click "Enter Post ID"

27.Paste in the Post ID of your initial Ad Post, then click "Submit"

28.Return to the main Ads Manager window by clicking "Collapse Side Pane"

29.Ensure that ALL of your Ads and Ad Sets are turned on (blue switch)

30.Click "Review and Publish", then click “Publish"


To copy your Fan Generator campaign to Instagram:


1. Log in to Instagram and upload a 60-second version of your Fan Finder video as a new post

2. Use your headline as the post text and post it to your Instagram page

3. Log in to Business Manager, then select "Ads Manager" from the top-left menu

4. Click on the "Campaigns" tab

5. Check off your newly created Fan Finder (FB) campaign, then click "Duplicate" and create a 

single copy of the campaign

6. Change the name of the Campaign to "VV - [INSERT SONG NAME HERE] - IG"

7. Navigate to the Ad Sets tab and check off all of your Ad Sets

8. Change the "Placement" to ONLY "Instagram Feed"

9. One by one, rename your Ad Sets to reflect "IG" instead of "FB"

10.Navigate to the "Ads" tab and check off all of the Ads in your campaign

11.Under "Use Existing Post", change or select the post

12.Find your post under "Instagram" and select it, then click "Apply"

13.Return to Ads Manager and click "Review and Publish", then click "Publish"


So, now that you’ve pressed ‘review and publish’, your campaign will be running and Facebook 
will be spending your money.


Once you’ve run the campaign for 24 hours, you’re going to want to optimise it, by shutting off or 
limiting the ad sets that aren’t working so well for you so that you can put your best foot forward 
with the budget that you have available to you. Regardless of whether you’re using campaign or 
ad set busiest optimisation, you can go ahead to the next chapter to learn more about 
optimisation, and then come back to your campaign to make adjustments.
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Chapter 6 | Running Your Campaign 

Optimising Your Campaign 

Once you have run your campaign for a minimum of 24 hours, you will want to look at the data 
about the performance of each Ad Set/Audience and, potentially, change some parameters of 
your campaign.


Facebook Ads is trying to get you the cheapest Cost-per-Thruplay, however, you are trying to get 
the cheapest cost per 50% or 75% View. You are looking for Ad Sets that have over $2 spent 
AND: 

1. a very low Cost-per-Thruplay but a very high Cost per 50-75% View

2. a very high Cost-per-Thruplay but a very low Cost per 50-75% View


In scenario 1, Facebook has determined that your Ad Set is good and will distribute a higher 
amount of your campaign budget to it. So, you must either shut the Ad Set off or set a maximum 
spend cap for the Ad Set.


In scenario 2, Facebook has determind that your ad set is bad and will distribute a lower amount 
of your campaign budget to it. So, you must set a minimum and maximum spend cap for the Ad 
Set.


To view your Ad Sets organized by Cost per 75% View, Cost per 50% View, or Cost per 
Thruplay, follow these steps:


1. Navigate to business.facebook.com and open Ads Manager

2. In a separate tab, navigate to sheets.google.com and create a new Spreadsheet

3. In Ads Manager, ensure that your "Columns" drop-down menu is set to "Video 

Engagement"

4. In the Campaigns tab, click on the Facebook version of your Fan Finder campaign, which 

will take you to the Ad Sets tab

5. On the right hand side of the screen, click "Reports" > "Export Table Data", select "Export 

as .csv", then click “Export"

6. Return to the campaigns tab and click the Instagram version of your Fan Finder campaign, 

which will take you to the Ad Sets tab

7. Repeat step 5

8. Return to Google Sheets and click "File" > "Import"

9. Upload the first of the two Ad Set reports you just downloaded

10.Select "Replace Current Sheet", then click "Import"

11.Highlight the first two columns, right click, then click "Delete Columns"

12.Highlight the first row, then click "View" > "Freeze" > "1 row"

13.Highlight the first column, then click "View" > "Freeze" > "1 column"

14. In the first open column on the right hand side of your spreadsheet, type "Cost per 50% 

View" in the first cell

15. In the next column, type "Cost per 75% View" in the second cell

16. In the second cell of the "Cost per 50% View" column, type the following formula 

=[COLUMN LETTER FOR "AMOUNT SPENT"]2/[COLUMN LETTER FOR "VIDEO 
WATCHES AT 50%"]2 
For example, if the column labeled "Amount Spent" is column L, and the column labeled 
"Video Watches at 50%" is column O, the formula would be "=L2/O2"


17.Repeat step 16 for the "Cost per 75% View" column, replacing "Video Watches at 50%" 
with "Video Watches at 75%"


18.Highlight the two cells you've just modified, then drag the bottom-right corner of the 
selection box all the way down the page


19.Click "File" > "Import"

20.Upload the second Ad Set report you downloaded from Ads Manager
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21.Select "Insert New Sheet" and click "Import"

22.Repeat steps 11 through 18

23.Lastly, to organize your Ad Sets by any metric, highlight the column and, in the top menu, 

click "Data" > "Organize by column __ A-Z"


Campaign Maintenance 

There are habits, processes, and rules you will need to learn and follow in order to get the most 
out of your Fan Generator campaign. In this lesson, we learn how to run your campaign - whether 
it’s a quick 2-week release or an evergreen, always-on affair.


1. Inviting all post likers to like your page 

Facebook likes aren’t actually very important when it comes to your music career; they won’t 
drastically improve your organic reach. They do however bring an element of social proof to any 
new visitors to your page, which can help things in a subtle way, including if you have any industry 
professionals checking out your page. 

Directions 
There is an extension for Google Chrome called Invite all post likers to like page (catchy, right?). 
Install it, then navigate to your Fan Finder post and click on the likes count on the post. This 
should bring up a list of all the users who have liked your post. Then, click on the Chrome 
extension in the top right of your browser and it will automatically invite everyone in this list to like 
your page. Be sure not to use Facebook while this extension is running, as any additional clicks in 
your Facebook account can trigger Facebook to realise you’re using a bot. If your campaign is 
spending a total of $5/day or less, perform this process once every couple of days. If you are 
spending more, perform this process daily.


2. Like/love all commenters/sharers 
More engagement on your post means better performance on Facebook - both on the ads 
platform and in organic reach. Keep the engagement fire stoked by reacting to any comments or 
shares you get while running your campaign. Remember that when new visitors come to engage 
with your content, the can see how you’ve responded to previous engagement and will easily be 
able to tell how genuine your responses are.


3. Reply (meaningfully) to any comments or shares  
Depending on how deep the comment or share is, you will want to reply to them whenever they 
occur. Avoid using boilerplate language to save time - actually respond meaningfully to the 
adoration and admiration you are receiving.


4. Delete or reply to any hateful or negative comments  
To put it simply, if someone is being a miserable dick, ban/block/delete them and their comment. 
If someone is just reacting negatively but their language or demeanor is tolerable, then it can be 
helpful and beneficial for your comments thread to turn the other cheek and write something nice 
or kind back.


5. If you wish to adjust your budget, use the 20/48 rule  
If you adjust your budget up or down too aggressively, your campaign will have to re-optimize. 
Facebook can't handle massive changes while staying optimized. Instead, use roughly 20% 
increases or decreases every 48 hours to bring your campaign up or down in budget so that 
performance is not impacted too dramatically.


For example, if you would like to go from spending $20 to spending $5 a day with the same 
amount of Ad Sets, do not jump down by $15 in one move. Instead, try reducing from $20 to $16, 
then waiting 48 hours, then reducing from $16 to $12.80, so on and so forth.
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Custom & Lookalike Audiences 

In this final tech lesson of the Fan Generator training, we will learn how to create Custom Video 
View Audiences. These Custom Audiences are the Return Path for this Introduction-stage 
campaign, and they will allow you to target those who have watched certain lengths of your Fan 
Finder video.


First, we will create your Custom and Lookalike Audiences in the Audiences panel. Then, we will 
exclude your 75% Video Viewers from each Ad Set in your campaign. Lastly, we will create a 
Lookalike Audience-only version of your campaign and measure the effectiveness of the 
Lookalike Audience against your interest-based Saved Audiences.


If you’re not sure whether you’re ready for this, you can find out by doing the following. Head over 
to your Facebook Business Ads Manager account, then select the Campaigns tab, and make sure 
your date selector is set to view the entire date range that your campaign spans. Now take a look 
at your ‘video watches at 75%’ column. If you have over 1,000 results here, then you’re good to 
go! If you want to create a custom audience off of your 95% video watcher, then again you want 
to be sure to have at least 1,000 results in that column. This will ensure Facebook has enough 
psychographic data to create a decent custom audience.


If you’re ready to go, then here’s how to create your custom audience…


• Select the ‘Audiences’ tab, which will take you to the ‘Audiences’ panel

• Select the drop down ‘Create Audience’ menu, then select ‘Custom Audience’

• On the ‘Create a Custom Audience’ pane that appears, select ‘Video’ under the ‘Use Facebook 

Source’ header

• Here another pane appears called ‘Create a Video Engagement Custom Audience’. You can 

select from the first drop down called ‘Engagement’, the appropriate option that suits your 
need, for example ‘People who have watched at least 75% of your video’. 75% is a good 
optimum percentage to select here


• Next, select the ‘Choose Video’ link immediately below

• Now you’ll see another new pane called ‘Select Videos’. Here select the drop-down menu 

called ‘Select by:’ and select ‘Campaign’. This will show us the campaigns that are currently 
running. Select your appropriate campaign and video here, and select ‘confirm’


• Now you’ll see the ‘Create a Video Engagement Custom Audience’ pane again. Select ‘365’ 
days in the ‘In the past’ box, and insert an audience name. It’s good practise to include some 
critical information in the name here, such as ’75% views’ as well as the campaign type (video 
views) and the name of the song for instance. Finish by selecting ‘Create Audience’


• Facebook may need some time to populate your new custom audience, but this shouldn’t take 
too long, maybe grab a snack!


Once your custom audience has populated, we can go ahead and create a lookalike audience…


• Head back into the ‘Audiences’ pane, select the same audience drop-down that we selected 
for our custom audience, only this time select ‘Lookalike Audience’


• A new pane appears called ‘Create a Lookalike Audience’. Firstly we’re going to select a 
lookalike source. This source will be the custom audience we’ve previously created.


• Select the drop-down menu and select ‘Other Sources’. Scroll through the list, where you 
should find your newly created custom audience. Again having a custom audience name that 
you recognise really helps here.


• Next we’ll select the audience location. Here I recommend inserting the big six locations; UK, 
US, Canada, Australia, Ireland and New Zealand.


• Next we’ll select our audience size. Here I recommend selecting a percentage that equates to 
around 10 million  people. This will typically be around 3% of the audience. Any more than this, 
and the results will be less targeted than is ideal.


• Lastly, select ‘Create Audience’


So now we have both our custom audience and lookalike audience, let’s take this a step further…
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• Head over to your Facebook campaign and select the ‘Ad Sets’ tab

• Select the check box below the green ‘Create’ button. This will select all of the ads sets in the 

campaign. Then select ‘edit’ with the pencil picture next to it, and the edit window will slide 
across the screen


• In the edit window, under ‘Audiences’ and next to ‘Custom Audiences’ select ‘EXCLUDE’. Here 
you can select the custom audience we previously created. This means our custom audience 
won’t keep seeing our ad on repeat.


• Select ‘Publish’ and now all of your selected ad sets will have been updated to exclude our 
previously created custom audience


But there’s more…


• Head on over to your Facebook Campaign again, and select the ‘Campaigns’ tab, then select 
that check box next to the campaign name again and click ‘Duplicate’


• The ‘Duplicate Campaign’ pane appears, where you’re going to then press the blue ‘Duplicate’ 
button


• Now head over to the edit pane that slides across the screen, and select the new duplicate 
campaign


• Edit the name of that campaign so that it indicates that it’s the Lookalike audience. I like to put 
‘- LL’ at the end so I know it’s a lookalike audience


And there’s still more…


• Head over to the Facebook Ads Manager, and select the ‘Ad Sets’ tab

• You’ll see all of the duplicated ads for the different audiences that were created. Basically we 

want to delete all but one of these, so go ahead and delete all but one of those ads so we’re left 
with just one


• Now select the ‘Ad set’ tab again and select ‘Edit’

• Then change the As Set Name to something appropriate. I like to put something like ’75% LL - 

Song/Campaign Name’

• Then scroll down to the ‘Audience’ section of the edit pane, and select your lookalike audience 

from the drop-down under ‘Create New’, so that it’s showing up in the ‘INCLUDE’ section

• Head further down to the detailed targeting and delete all the information held in that box


Now we have the lookalike audience properly set up. You can head over to the Campaign level of 
the Ads Manager, and alter the campaign budget if you wish. I recommend lowering it 
considerably as you’ll likely have a fairly high budget in this window, as left over from the testing 
phase. So bring this down to say $10 daily budget.


From here we’re simply going to let the two campaigns run for 24 hours and then compare them. 
You’ll likely find that the custom and lookalike audience out performs the campaign you set up 
previously, in which case you can simply turn the original campaign off for now. And the beauty of 
this setup is that as Facebook gathers more and more data, it will constantly improve the 
performance of the custom audience, which will in turn improve the performance of the lookalike 
audience.


To know which campaign is performing best, simply calculate the ‘cost per video watch 
percentage’ of each campaign. 


To do this…


• Set the date selector within the Facebook Ads Manager to the last 48 hours

• Take the ‘amount spent’ on each campaign, and divide this by the the number of video views 

received. I recommend using the 75% video views count here but use whichever makes most 
sense to you and your campaign


• This will give you the cost per video watches for each campaign
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• You can also change the date selector to show whichever time period you like, where you can 
then run the calculations again if you wish


Some further maintenance on this includes heading over to the slide-across edit pane again, and 
selecting the tiny little icon above the edit pencil that looks like a graph and says ‘view chart’ 
when hovering over it. This will show performance over time depending on where your date 
selector is set. You’ll see here how your average cost per result should drop over time.
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Chapter 7 | Advanced Skills 

Formats & Captions 

For some genres of music and listener demographics, formats and captions can dramatically 
impact the performance of a Fan Generator campaign. 

In this lesson, we examine the data and observations behind this strategy and how you can 
implement and test it in your next Fan Generator campaign.


Some things to consider…


• A square video. This will take up the optimum amount of visual real estate on a phone screen in 
a Facebook feed. This doesn’t mean you should always use square videos; if you already have 
beautiful landscape video, that’s just fine. But tests have shown that the square video actually 
out performs even the portrait-oriented video


• Captions, headers and footers. Often viral videos will have a caption at the top, bottom or both 
top and bottom of the video. If you’d like, you can try this technique in your music video. Copy 
such as ‘Rapper murders freestyle’ or ‘Best guitarist ever’, or ‘Street musician plays…then this 
happens’, can often garner more views and even make a video go viral. This concept does 
carry inherent risk though, and can certainly put certain people off of a video. That said, if you 
see lots of videos in your feed with captions in the video, then that might be an indicator that 
you’re part of a community that will accept that technique, so maybe try it. If you’re totally put 
off by the idea then definitely don’t do this one


• Lyrics of spoken-word captions. Sometimes musicians in particular worry that their music isn’t 
heard when people have the sound off on their device. One thing to try to help persuade 
someone to continue to watch and/or turn on their audio, is to include captions for the words of 
the song or just captions for anything being spoken. This has been proven to help video view 
counts. You can either create your video with captions included, or you can have Facebook 
generate captions. 


To do this…


• Go to business.Facebook.com/yourpage

• Then Publishing Tools

• Then Video Library

• Select the video you’d like to add captions to

• A new pane will appear where you can select ‘Subtitles and Captions’

• Then select ‘Generate’, which will automatically generate the captions

• Be sure to read the auto-generated captions and edit them where necessary, because they 

almost certainly won’t be 100% accurate initially


Something to consider here is that typically when a user turns on their audio while watching a 
video, the auto-generated (and edited) Facebook captions will turn off. So with that in mind, make 
a decision as to whether you want to include the captions yourself or to have Facebook include 
them. I personally recommend including the captions yourself because people consume in 
different ways, and covering both audio and visual in this way should cover more bases. Of 
course you could always run some tests on this if you wish.
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Advanced Data Analysis 

Over time, your need for and ability to process data will gradually increase. Facebook Ads is one 
of the most advanced marketing data tools available to the average person, but most people 
(even professional marketers) don't use its more advanced features.


In this lecture, you will have a front row seat to a full breakdown of all the data available to you in 
your Ads Manager.


Firstly let’s take a brief look at the columns selector and some of the more relevant options that 
allow you to look at various metrics regarding your campaign.


• Delivery. This will give you your CPR (cost per one thousand people reached), and CPM (cost 
per one thousand impressions)


• Engagement. Reactions, comments, shares, link click and page likes

• Video engagement. The distribution throughout. Here is traditionally where marketers will check 

out the number of people who are watching beyond that 3 second mark and into the 10 second 
mark. Usually you’ll see that around 20/30% of the audience remains past that 3 second mark 
and into the 10 second mark. You can then look at the 25% views, which can vary dramatically 
depending on the overall length of the video. If the video is around 2 minutes you might lose 
50% of your audience here, whereas if its a 4-minute video you’re more likely to lose 80% of 
your audience here. Then the 25%-50% views, you’d typically see another 50% of the 
audience drop off here, and again another 50% drop off at the 50%-75% views, and yet 
another 50% drop off at the 75%+ views.


• Performance and Clicks. Here you’ll find all the usual metrics but one to look at for interest is 
the click through rate, which is typically going to be around 0.5%


• Targeting and Creative. This is very similar to ‘Performance and Clicks’ only it’s more of a direct 
snap shot into how your Creative is performing in the context of your audience targeting


• Messenger Engagement. Some handy metrics here if you’re running any messenger campaigns


If you select the ‘Customise Columns’ button, you’ll see a new pane appears where we can 
indeed customise the columns that appear at the campaign view. Some that are worth noting and 
researching are…


• Reach

• Social reach

• Social impressions

• Actions

• Positive and Negative feedback (more negative feedback makes campaign costs rise and thus 

you may like to renew and upload a fresh campaign if this issue happens to fatigue your 
campaign)


• Gross impressions

• Auto refresh impressions

• Page post engagements, likes, comments, shares etc

• Messaging

• All the important video view metrics 25%, 50%, 75% etc

• Conversion value

• On Facebook purchases

• Lead forms


These metrics can be added to and saved as a custom column for future use. I won’t go into 
detail with these advanced metrics in this training, but they are worth taking a quick look at for 
now.
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The Education Funnel 

The second stage of the ‘Fan Journey’ system is ‘Education’. It’s difficult to understand and even 
more difficult to achieve with an intentional campaign. Many artists just starting out will need to 
rely on the ‘low-hanging fruit’, ie those fans who ‘self educate’ themselves all about you and your 
music.


Although I won’t go into detail here, I do just want to tell you a little about this critical next step in 
the system that will help move new fans through the fan/artist relationship and help them to move 
toward becoming a long-term buying raving fan and customer.


An education funnel is an ad campaign using your Fan Generator video, only this time viewers will 
be re targeted with further video ads based on how engaged they were by the initial Fan 
Generator video. For instance, a second video ad could be targeted to those who watched 50% 
or more of the initial video, then a third video could be targeted to those who watched 50% or 
more of the second video, and so on like a daisy chain of videos. The benefit with this is that it 
acts as an education strategy and warms up your audience. Education (and more) is critical to 
ascending a cold audience viewer into a buying raving fan/customer.


Most potential new fans will need more information than just the initial Fan Generator before they 
want to move further into a fan relationship with you the artist; and most potential fans won’t self 
educate, so it’s on you to do this. Some will educate themselves of course, they’ll take it upon 
themselves to head over to your page, check out all your music, watch your content, and sign up 
for your offer; but most won’t do this.


So, firstly the video ad funnel is great and clever but not always the best thing to do; it does 
depend on whether it fits with your larger vision of course.


I should also point out that unless you have more than around 100 raving paying fans already, 
then you should just focus purely on those fans who do self educate, rather than spend money on 
an education funnel ad campaign.


Those who do run an education funnel with several re targeted educating videos, will find that 
they garner better results from their Fan Generator campaign, because a higher percentage of 
that initial warm audience will move through the funnel and eventually become a real fan of yours.


If you find your education videos have differing levels of engagement about them, then use the 
best one first, and the next best as the second video and so on.


An education funnel is often nice if you have a video narrative in mind, or some story that might 
unfold throughout the videos, or perhaps if you want to walk your audience through your own 
story and lead them to the point of becoming a fan.


So, if you’re interested in learning more about this, I’ll be looking to create another course on this 
part of the fan journey, what I’m calling the ‘Fan Journey’ system.
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Summary 

Thank you so much for reading through my ebook all about garnering real fans with a systematic 
approach. 


Please do keep in contact, let me know if you have any questions, and also what you think of the 
content of this book, how I might improve it.


See you in the next training!


Brad x


@PureMusicMarketers

PureAcademyOfMusic@gmail.com
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